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Keyboard shortcuts for Windows 
Gowtham Patel II BCA-C 

This article lists keyboard shortcuts that you can use 
with Windows.  
Windows system key combinations 

• F1: Help 
• CTRL+ESC: Open Start menu 
• ALT+TAB: Switch between open programs 
• ALT+F4: Quit program 
• SHIFT+DELETE: Delete item permanently 
• Windows Logo+L: Lock the computer (without using 

CTRL+ALT+DELETE) 

Windows program key combinations 

• CTRL+C: Copy 
• CTRL+X: Cut 
• CTRL+V: Paste 
• CTRL+Z: Undo 
• CTRL+B: Bold 
• CTRL+U: Underline 
• CTRL+I: Italic 

Mouse click/keyboard modifier combinations for shell 
objects 

• SHIFT+right click: Displays a shortcut menu 
containing alternative commands 
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• SHIFT+double click: Runs the alternate default 
command (the second item on the menu) 

• ALT+double click: Displays properties 
• SHIFT+DELETE: Deletes an item immediately 

without placing it in the Recycle Bin 

General keyboard-only commands 

• F1: Starts Windows Help 
• F10: Activates menu bar options 
• SHIFT+F10 Opens a shortcut menu for the selected 

item (this is the same as right-clicking an object 
• CTRL+ESC: Opens the Start menu (use the ARROW 

keys to select an item) 
• CTRL+ESC or ESC: Selects the Start button (press 

TAB to select the taskbar, or press SHIFT+F10 for a 
context menu) 

• CTRL+SHIFT+ESC: Opens Windows Task Manager 
• ALT+DOWN ARROW: Opens a drop-down list box 
• ALT+TAB: Switch to another running program (hold 

down the ALT key and then press the TAB key to 
view the task-switching window) 

• SHIFT: Press and hold down the SHIFT key while 
you insert a CD-ROM to bypass the automatic-run 
feature 

• ALT+SPACE: Displays the main window's System 
menu (from the System menu, you can restore, move, 
resize, minimize, maximize, or close the window) 

• ALT+- (ALT+hyphen): Displays the Multiple 
Document Interface (MDI) child window's System 
menu (from the MDI child window's System menu, 
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you can restore, move, resize, minimize, maximize, 
or close the child window) 

• CTRL+TAB: Switch to the next child window of a 
Multiple Document Interface (MDI) program 

• ALT+underlined letter in menu: Opens the menu 
• ALT+F4: Closes the current window 
• CTRL+F4: Closes the current Multiple Document 

Interface (MDI) window 
• ALT+F6: Switch between multiple windows in the 

same program (for example, when the Notepad Find 
dialog box is displayed, ALT+F6 switches between 
the Find dialog box and the main Notepad window) 

Shell objects and general folder/Windows Explorer shortcuts 

For a selected object:  

• F2: Rename object 
• F3: Find all files 
• CTRL+X: Cut 
• CTRL+C: Copy 
• CTRL+V: Paste 
• SHIFT+DELETE: Delete selection immediately, 

without moving the item to the Recycle Bin 
• ALT+ENTER: Open the properties for the selected 

object 

To copy a file 

Press and hold down the CTRL key while you drag the file to 
another folder.  
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To create a shortcut 

Press and hold down CTRL+SHIFT while you drag a file to the 
desktop or a folder.  

General folder/shortcut control 

• F4: Selects the Go To A Different Folder box and 
moves down the entries in the box (if the toolbar is 
active in Windows Explorer) 

• F5: Refreshes the current window. 
• F6: Moves among panes in Windows Explorer 
• CTRL+G: Opens the Go To Folder tool (in Windows 

95 Windows Explorer only) 
• CTRL+Z: Undo the last command 
• CTRL+A: Select all the items in the current window 
• BACKSPACE: Switch to the parent folder 
• SHIFT+click+Close button: For folders, close the 

current folder plus all parent folders 

Windows Explorer tree control 

• Numeric Keypad *: Expands everything under the 
current selection 

• Numeric Keypad +: Expands the current selection 
• Numeric Keypad -: Collapses the current selection. 
• RIGHT ARROW: Expands the current selection if it 

is not expanded, otherwise goes to the first child 
• LEFT ARROW: Collapses the current selection if it 

is expanded, otherwise goes to the parent 

Properties control 
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• CTRL+TAB/CTRL+SHIFT+TAB: Move through the 
property tabs 

Accessibility shortcuts 

• Press SHIFT five times: Toggles StickyKeys on and 
off 

• Press down and hold the right SHIFT key for eight 
seconds: Toggles FilterKeys on and off 

• Press down and hold the NUM LOCK key for five 
seconds: Toggles ToggleKeys on and off 

• Left ALT+left SHIFT+NUM LOCK: Toggles 
MouseKeys on and off 

• Left ALT+left SHIFT+PRINT SCREEN: Toggles 
high contrast on and off 

Microsoft Natural Keyboard keys 

• Windows Logo: Start menu 
• Windows Logo+R: Run dialog box 
• Windows Logo+M: Minimize all 
• SHIFT+Windows Logo+M: Undo minimize all 
• Windows Logo+F1: Help 
• Windows Logo+E: Windows Explorer 
• Windows Logo+F: Find files or folders 
• Windows Logo+D: Minimizes all open windows and 

displays the desktop 
• CTRL+Windows Logo+F: Find computer 
• CTRL+Windows Logo+TAB: Moves focus from 

Start, to the Quick Launch toolbar, to the system tray 
(use RIGHT ARROW or LEFT ARROW to move 
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focus to items on the Quick Launch toolbar and the 
system tray) 

• Windows Logo+TAB: Cycle through taskbar buttons 
• Windows Logo+Break: System Properties dialog box 
• Application key: Displays a shortcut menu for the 

selected item 

Microsoft Natural Keyboard with IntelliType software 
installed 

• Windows Logo+L: Log off Windows 
• Windows Logo+P: Starts Print Manager 
• Windows Logo+C: Opens Control Panel 
• Windows Logo+V: Starts Clipboard 
• Windows Logo+K: Opens Keyboard Properties 

dialog box 
• Windows Logo+I: Opens Mouse Properties dialog 

box 
• Windows Logo+A: Starts Accessibility Options (if 

installed) 
• Windows Logo+SPACEBAR: Displays the list of 

Microsoft IntelliType shortcut keys 
• Windows Logo+S: Toggles CAPS LOCK on and off 

Dialog box keyboard commands 

• TAB: Move to the next control in the dialog box 
• SHIFT+TAB: Move to the previous control in the 

dialog box 
• SPACEBAR: If the current control is a button, this 

clicks the button. If the current control is a check box, 
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this toggles the check box. If the current control is an 
option, this selects the option. 

• ENTER: Equivalent to clicking the selected button 
(the button with the outline) 

• ESC: Equivalent to clicking the Cancel button 
• ALT+underlined letter in dialog box item: Move to 

the corresponding item 

WINDOWS MBL OS MANGO 7.5 

What's new in Windows Phone 7.5 

A.Aravindh III BCA-A 

  The latest release of Windows Phone has hundreds of 
improvements and new features. Here's a sampling of the smart, 
the fun, and the just plain cool. 

Notes 

Some features may work differently or not at all if your phone 
has 256 MB of RAM. To find out how much memory your 
phone has, on Start, flick left, tapSettings, and then tap About. 
For more information, contact your mobile operator. 

Some features might not be available in your country or 
region. For more information, see Feature and service 
availability. 

http://www.microsoft.com/windowsphone/en-us/howto/wp7/basics/feature-and-service-availability.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/basics/feature-and-service-availability.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/basics/feature-and-service-availability.aspx
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If you're not seeing all of the features described here, you 
might not have the latest software update on your phone. 
For more information, see Phone updates FAQ. 

Phone 
Custom ringtones:You asked for it, we built it—now you 
can create your own ringtones using MP3 and WMA files. You 
can even save an audio file from a text message and make it a 
ringtone. 

Visual voicemail:See your voicemails in a list, then listen to 
them on your phone. 

Battery Saver:Not sure you'll make it to 
the next charge? Turn on Battery Saver to 
make the juice last a bit longer—you can 
even set it to turn on automatically when 
your battery is running low. 

Email + messaging 
Send a text with your voice:That's right: 
with Speech, you can text, search the web, 
and lots more, totally hands- (and 
sometimes eyes-) free. Your phone can 
even read you an incoming text, and then 
you can use Speech to dictate and send 
your reply. 

Better media messaging. Now you can attach multiple pictures 
and videos—along with voice notes and ringtones—to text 

http://www.microsoft.com/windowsphone/en-us/howto/wp7/basics/phone-updates.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/start/create-ringtones.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/start/check-my-voicemail.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/basics/battery-making-it-last.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/basics/use-speech-on-my-phone.aspx
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messages. You can include a video, picture, voice note, or 
ringtone in an instant message, too.  

Threads:Start with a text, and finish in Facebook or Messenger 
chat (or vice versa). The whole conversation stays in one thread, 
and all it takes to switch back and forth is a tap.  

Facebook Chat:It's now built into your phone—you can set it 
up in Messaging in a few taps. 

Conversation view:If you're fed up with deleting emails one by 
one or sifting through your inbox for related messages, 
then conversation view—emails grouped by subject—is for you. 
If you'd rather see your emails individually, you can still do that, 
too. 

Linked inboxes:Juggling multiple accounts for 
personal or work email? Streamline things by 
linking them into a single inbox to see all the 
messages in one view (the accounts will stay 
separate). 

People + social networking 
Groups:Groups help you focus on the contacts 
you really care about—family, best friends, 
fellow soccer parents. You can pin your top 
Groups to Start to see everyone's latest status updates and to 
send quick texts, emails, or IMs to the whole Group. 

More ways to share:You've got great new options for posting 
to social networks from your phone, including Facebook check-

http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/set-up-a-facebook-account.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/set-up-a-facebook-account.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/set-up-a-facebook-account.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/group-messages-by-conversation.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/link-my-email-accounts.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/create-edit-or-delete-a-group.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/post-to-facebook-and-windows-live.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/post-to-facebook-and-windows-live.aspx
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ins, video sharing,and sharing a link right from Internet 
Explorer. 

More social networks:Never be out of the loop again: Twitter 
and LinkedIn are now built into Windows Phone, so practically 
everything you do on your social networks is a tap away. And 
don't worry—we've also included new ways to filter all those 
new contacts and their social updates. 

A better Me card. It's all about Me—and the Me card is now one 
of the most useful spots on your phone for staying in touch with 
your friends and keeping tabs on your social networks. 

History view. Contact cards now show the history of your recent 
calls, emails, texts, and chats with the person. Just tap in the list 
to return the call or go to the thread. 

Smarter apps 
Multitasking:Keep your place in a game 
while reading email? Check. Listen to music 
apps while texting? You bet. Many apps can 
run in the background, so you don't need to 
shut one down to use another—plus you can 
switch between open apps in a flash.  

App Connect:Get the app you need—
sometimes before you even know you need it. Search the web, 
and alongside the usual results you'll see apps you can use—like 
a movie app when you're looking up showtimes. You'll also see 
photo apps in the Pictures Hub and music apps in Music + 
Videos. 

http://www.microsoft.com/windowsphone/en-us/howto/wp7/pictures/upload-pictures-to-the-web.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/web/navigating-webpages.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/web/navigating-webpages.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/web/navigating-webpages.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/social-networking.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/find-a-contact-quickly.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/find-a-contact-quickly.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/find-a-contact-quickly.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/what-is-the-me-card.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/contacts.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/apps/download-apps-and-games-faq.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/web/searching-for-stuff.aspx
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Improved Live Tiles:The Live Tiles on Start dish up more (and 
quicker) updates on your apps, and they're also a whole lot of 
fun—the Pictures Tile animates with a slideshow of your 
favorite snapshots and Group Tiles flash your friends' latest 
updates. 

More in Marketplace: Marketplace has an ever-expanding 
lineup of standout apps and marquee games, and it's now easier 
to find what you want in the online store. So start limbering up 
those gaming thumbs! 

A cleverer calendar. More ways to tame that crazy schedule—
view multiple sub-calendars within a single account, see and 
respond to Facebook events, and create a to-do list complete 
with due dates and reminders. Your Outlook tasks will show up 
there, too! 

Browsing + maps 
Better search. Bing helps 
you search the web in more ways, 
with voice search, Music search, 
and Vision search, which uses your 
phone's camera to look up product 
info. 

Local Scout. Live like a local! 
Local Scout, powered by Bing, teams up search and mapping 
toshow you nearby restaurants, shopping, and activities in a 
single tap, so you'll never feel like a clueless tourist again. 

http://www.microsoft.com/windowsphone/en-us/howto/wp7/start/start-from-the-beginning.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/apps/marketplace-hub.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/people/calendars.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/web/searching-for-stuff.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/web/what-song-is-this.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/web/scan-codes-tags-and-text.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/web/local-scout.aspx
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Mall maps: Desperately seeking the food court? Zoom in on the 
mall in Maps (or go to its Place card) and you might find an 
indoor map to help you track down the nachos. 

Driving directions. Your Windows Phone can get you where 
you're going by showing you on the map or giving you 
directions from where you are. 

Pictures + camera 
Video sharing:Send them in email or post them to Facebook or 
Windows Live.  

Picture tagging:Your phone 
automatically detects 
untagged faces when 
you're uploading pictures to 
Facebook or Windows Live—
just tap, tag, and post. 

Persistent camera 
settings: Now if you change 
camera settings—for instance, photo resolution, brightness, or 
another option your phone manufacturer might have included—
you can save them for the next time you use the camera.   

A redesigned Pictures Hub. The Pictures Hub just got more 
personal, more social, and more fun. 

Music + videos 

http://www.microsoft.com/windowsphone/en-us/howto/wp7/web/use-maps-to-find-a-place.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/web/use-maps-to-find-a-place.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/web/use-maps-to-find-a-place.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/web/use-maps-to-find-a-place.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/pictures/upload-pictures-to-the-web.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/pictures/pictures-hub.aspx
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Playlists:Add songs to Now Playing and then save them as a 
playlist, all on your phone. 
Smart DJ;Play Smart DJ mixes on your phone—or if you've got 
a Zune Music Pass, you can stream them from Zune. 

Podcasts;Subscribe to podcasts—audio or video—on your 
phone. 

Office Mobile 
Sync with SkyDrive. You can sync your Office docs between 
SkyDrive and your phone, so you can edit them on your phone 
now, then edit some more on your 
computer later. 

An expanded Office Hub. The 
improved Office Hub has more ways to 
view, navigate, and search for your docs. 

Information rights management. Got an 
IRM-protected email or Office doc? Now 
you can open it on your phone.Excel 
improvements. Excel Mobile on your 
phone has easier cell selection—just tap 
and drag—plus AutoSum for quick 
calculations.Office 365 integration. Office 
365 takes your business to the cloud—and 
Windows Phone supports Office 365 right out of the 
box.OneNote to-do lists. Check off your errands one-by-one 
with this handy new feature in OneNote. 

http://www.microsoft.com/windowsphone/en-us/howto/wp7/music/create-a-playlist.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/music/create-a-playlist.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/music/create-a-playlist.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/music/music-and-video-faq.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/music/subscribe-to-podcasts.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/office/sync-documents-with-skydrive.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/office/sync-documents-with-skydrive.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/office/office-hub.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/office/office-mobile-faq.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/office/use-office-excel-mobile.aspx
http://go.microsoft.com/fwlink/?linkid=232541
http://go.microsoft.com/fwlink/?linkid=232541
http://go.microsoft.com/fwlink/?linkid=232541
http://www.microsoft.com/windowsphone/en-us/howto/wp7/office/use-office-onenote-mobile.aspx
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Games 
A revamped Games Hub. Now you can do more in the Games 
Hub—including track your achievements, dress up your avatar, 
and get messages from your Xbox LIVE friends. 

Networking 
Internet connection sharing. Turn your phone into a mobile 
Wi-Fi hotspot by sharing your Internet connection with your 
laptop and other devices. 

Hidden Wi-Fi networks. Now you can connect to hidden Wi-Fi 
networks (networks that don't broadcast their network name). 

My Phone 
Manage your phone on the web. Find a lost phone, see your 
pictures and Xbox stats, reinstall apps, and more on the My 
Phone page. 

Automatically shutdown with 
SleepWalker 

Vidhyasagar Rajkumar II BCA-A 

 If you have a habit of using your laptop for internet 
and social sites like Facebook before falling asleep. 
For all those who are like you and uses their 
computer for either watching movies, using internet etc before 
falling asleep, might see their system running the next day too 
when they wake up from the sleep. This had happened to and 
can happen with you too. 

http://www.microsoft.com/windowsphone/en-us/howto/wp7/apps/games-hub.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/apps/games-hub.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/apps/games-hub.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/apps/set-up-an-xbox-live-account.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/start/share-my-connection.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/start/connect-to-a-wi-fi-network.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/start/connect-to-a-wi-fi-network.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/basics/find-a-lost-phone.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/apps/delete-apps-and-games.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/basics/my-windows-phone-faq.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/basics/my-windows-phone-faq.aspx
http://www.microsoft.com/windowsphone/en-us/howto/wp7/basics/my-windows-phone-faq.aspx
http://www.softgenius.co.in/2012/11/automatically-manage-computer-power-and.html
http://www.softgenius.co.in/2012/11/automatically-manage-computer-power-and.html
http://www.softgenius.co.in/2012/11/automatically-manage-computer-power-and.html
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Well to overcome this situation we have lots of automatic 
computer shutdown tools in 
the market, some of which we 
have already reviewed but here 
is another one called 
SleepWalker which have some 
little different features to help 
us. This small yet powerful tool 
can help us in getting our 
computer in any of the set power 
saving modes like hibernation, 
standby etc to curb that extra 
consumed useless power unit. 
 
Apart from turning the computer Off, switching to hibernation, 
standby and other modes it can also fire up the screensaver, run 
a file of your choice, or merely log you off. SleepWalker is so 
small and user-friendly that it can be easily copied on a flash 
drive, and then moved from 
computer to computer. 
Moreover in case your system is 
hung, it can force shut it down 
too. 
You can either get the computer 
change mode automatically or 
can create hotkeys of your 
choice to get this done 
manually. When selected to 
work automatically, the tool can 
schedule the actions and events 
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on that actions at any selected time. This can be done on a 
regularly basis too, like daily, monthly, hourly etc. The tool also 
has password protection for added security. 
 
Apart from these actions, it can be used to clean temp files too 
and that again, automatically. You can customize the tool in 
your own way as well. The Idle Shutdown feature of the tool 
turns the computer off when there is no user activity for some 
specified time. 
 

The Best Computer Tips and Tricks: 
iTunes 

D.Kavin Kumar II B.Sc Cs “C”  

On-the-fly equalizer  

If you want a quick way to adjust equalizer settings, 
you can add an EQ column in your view options. Go to 
View > View Options, and check Equalizer. The EQ 
column will appear with pull-down menus that let you 
choose the appropriate EQ setting.  

Right-click Options  

Some of iTunes's features can be accessed via right-
clicking. Use the "Get Info" option to view details 
about a song and the associated file and to edit any 
info. You can also convert the song to another file 
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type, and download free album art from the iTunes Music Store.  

Make Shuffle More Random  

Sometimes iTunes repeatedly plays the same artist in shuffle 
mode. To make shuffle selections more random, head to the 
Playback pane in Preferences and drag the slider in the Smart 
Shuffle setting all the way to "less likely."  

Stream Faster  

In the Advanced pane of Preferences, you can adjust the 
streaming buffer size based on your Internet connection. If you 
are on dial-up, you can still get smooth playback by changing to 
a larger buffer size; you'll just have to deal with a longer wait. 
Those with a speedy broadband connection will want to use a 
smaller buffer size for quicker playback.  

Parental Controls  

If there's questionable content in your library that you don't want 
your youngsters exposed to, simply set the parental controls in 
Preferences (under Edit). You can also restrict what they buy 
from the iTunes Music Store.  

Turn iTunes into a PDF Manager  

If you're scratching your head over this tip (iTunes and "¦ 
PDFs?), read on. iTunes has PDF support because some 
purchases on the iTunes Store come with accompanying 
documentation. Thus, you can drag-and-drop PDFs in iTunes as 
you would songs (a book icon appears next to the file name in 
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the library). Create a separate iTunes folder, and now you have a 
great way of managing your PDFs.  

Back up Your Music Library to Disc  

If you're worried about losing your iTunes collection, try the 
"Back Up to Disc" function in the File menu, which will burn 
your entire collection to DVD or CD. (You'll be prompted to 
insert another disc if you're collection is larger than one disc's 
capacity.) Keep in mind that this is just meant to back up your 
collection—the discs won't play in DVD or CD players.  

Create a Separate Music Library  

If you want to start a new library in iTunes without getting rid of 
the old one, then hold down the Shift key when launching 
iTunes. You'll be given the option of creating a new library.  

Find Duplicate Songs  

If you do a lot of downloading, then chances are you might have 
a few duplicates in your collection. To get rid of them, go to 
View > Show Duplicates, then delete the extra copies.  

Change iTunes' Default Audio Format  

CDs ripped to iTunes will be encoded into AAC format by 
default. This can be changed by going to Edit > Preferences, 
then clicking on the Advanced tab. Once you're there, select the 
Importing tab, open the dropdown menu, and choose whichever 
format you want your tunes encoded in.  

Mouse-free Tunes  
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You don't need to rely on your mouse when you're in iTunes—
several keyboard shortcuts can take care of most basic functions. 
Tapping the spacebar, for example, will pause a track. Hitting 
left or right will go to the previous song or move on to the next 
one, respectively, while holding Ctrl. And moving the up or 
down arrows will raise or lower the volume.  

On the Move  

If you want to take iTunes off your task bar and move it into the 
system tray, where it will be less obtrusive, then simply go to 
Edit > Preferences, select the Advanced tab and, under the 
General tab, check the box next to "Minimize iTunes window to 
system tray."  

System Tweaks 
                    S.V.Vetrivel II B.Sc (CS)-C 

Disable System Restore  

You can gain a lot of drive space by disabling System 
Restore. (You should already have a backup regimen 
in place before you do this.) In Vista, right-click My Computer, 
select Advanced system settings, click the System Protection 
tab, and uncheck any drives. In XP, right-click My Computer, 
then under System Tasks, click on "View system information." 
Click on the System Restore tab and click the box next to "Turn 
off System Restore on all drives" to disable it.  

Configure Windows Update  
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Windows Update is great, but if it's set on autopilot, it will 
download updates that require a reboot, then pester you forever 
to install them, and eventually reboot on its own. Change the 
Windows Update settings (in the Windows Security section of 
the Control Panel) to download updates but ask you whether to 
install them.  

 

Disable Delete Confirmation  

You can disable the 
confirmation that pops up 
whenever you delete something 
by right-clicking the Recycle 
Bin and selecting Properties. 
Uncheck the delete confirmation 
box, click Apply and then OK, and you're done. Also, you can 
bypass the Recycle Bin entirely by holding down the Shift key 
while deleting files.  

Disable Windows Animations  

Sliding Window animations look cool, but you can improve 
system performance by disabling them completely. Right-click 
My Computer and go to Properties. In Vista, select Advanced 
system settings, or click the Advanced tab in XP. Click Settings 
in the performance box and uncheck any box that says animate, 
slide, or fade.  

Create a Custom Toolbar  
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If you're constantly accessing a particular folder, you can add it 
to your taskbar for quick access. Right-click the taskbar and 
scroll to Toolbars, then select New Toolbar. It will open an 
Explorer window, so browse to your folder and select it. It's also 
handy to add My Computer as a toolbar.  

 

Install a New Hard Drive in Five Easy 
Steps 

C.Gnanasekaran I B.Sc CS-A 
 One PC truth is unshakable: It's impossible to have 
too much hard drive space. Digicam images, space-
hog programs, and music files demand ever more 
storage. 
 
Fortunately, mammoth-capacity upgrades are inexpensive (many 
250GB drives cost less than $100), and you can install one in 
less than 30 minutes, not including formatting time. Here's how 
to install a new internal drive as extra storage or as a new boot 
drive. Here, we installed Seagate's Barracuda 7200.10, a $124, 
320GB Serial ATA (SATA) drive, inside a Dell Dimension 
8400 running Windows XP Home Edition.  
 
Step 1: Back up and scout around 
 
First, back up your critical files (don't forget 
your Outlook .PST archive) to optical discs, an 
external drive, or online storage. Then check 
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whether a CD comes with the drive, providing drive-specific 
information and general upgrade assistance. It may also later 
help you copy the contents of one drive to another. Install this 
software first. Then, power down your PC, unplug all cables, 
and open the case. Next, ground yourself by touching a metal 
portion of the chassis. 
 
Look inside—your first task is to determine where your new 
drive will go. Bays for internal drives are usually located below 
the wider, front-accessible bays that house CD or DVD drives. If 
you plan to replace your boot drive with the new drive and don't 
have an empty bay, your upgrade will involve more steps than 
we can cover here. But if you're replacing your boot drive and 
you have an empty bay, follow our steps for adding a second 
drive. After formatting it, use Norton Ghost (or a similar 
program) to clone your boot drive's contents to the new drive. 
Then, revisit steps 3 and 4 to direct your PC to boot from the 
new drive. 
 
We'll be installing a SATA drive, but the process is similar for 
the other common drive type, IDE. SATA drives use a thin, 
seven-pin data cable; IDE drives use a 40-pin ribbon cable that's 
usually gray. If you're unsure which drive type your PC already 
has, check its documentation or label. Most PCs more than a 
year or two old employ IDE hard and optical drives, and don't 
support SATA unless they have a SATA PCI card installed. 
More-recent desktops may use (or just support) SATA drives 
but should support IDE, too. 
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Tip: If you transfer Windows XP from one 
drive to another, you may have to 
reauthorize Windows.  
 
Step 2: Examine data and power connections  
 
Tracing along the SATA cable of an installed drive will lead you 
to the SATA connectors on youPC's motherboard.  
Most hard drive kits include a data cable (SATA or IDE, 
depending on the drive), a power adapter cable (with some 
SATA drives), and screws. If yours doesn't include cables, you 
can purchase them separately. 
First, the data connection. If you're installing a SATA drive as 
secondary storage, follow the data cable from your current drive 
(assuming it's SATA, too) to the other end. See if an unused 
SATA port lies nearby on the motherboard or an interface card. 
If you can't find one, consult your PC's documentation. 
If you're adding an IDE drive as a second drive, you may be able 
to connect it to the same data cable as your primary IDE drive, 
or along with an IDE optical drive. Look for a third, free 
connector in the middle of the cable that connects your currently 
installed IDE drive to the motherboard. Note that some older 
PCs use 40-conductor IDE cables, not 
the 80-conductor ones current drives 
require. (Compare your kit cable to the 
one installed—the 80-conductor variety 
has much thinner wires.) 80-conductor 
cables are backward-compatible (both 
types use the same 40-pin connector), so 
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you can swap out a 40-conductor cable for your kit's 80 if need 
be. (The "master" drive goes at the end—see step 3.)  
 
Once you've located an empty bay for your drive, make sure the 
relevant data (left) and power (right) cables will reach.  
 
Next, consider the power connection. Our SATA drive has a 15-
pin SATA power connector. If you already have a SATA drive 
installed, follow its power cable (the wider of the two 
connectors) to see if an unused power-supply lead with the same 
connector is nearby. If so, earmark that lead for your new drive. 
If it can't reach the empty bay, see if any bundled adapters help. 
 
Some SATA drives also support familiar legacy Molex four-pin 
power connectors—you can use a Molex or SATA connector. If 
so, hunt for a free Molex-style lead. Still no match? Then you'll 
need an adapter, such as a Molex-to-SATA adapter (some kits 
bundle one), or a Y-adapter that splits a 
lead in two. 
 
IDE drives are simpler: They always use 
Molex connectors. You just need a free 
Molex-style lead (or a Y-splitter).  
 
Step 3: Mount and connect the drive  
 
The SATA data connector is keyed so you 
can't install it upside-down.  
 
When installing SATA drives, jumper settings usually aren't an 
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issue. That's not true of IDE, where a jumper indicates whether a 
drive is a primary ("master") or secondary ("slave") drive. 
Check its documentation for the proper setting. If your PC has 
only one IDE hard drive, it's probably set to "master." Assuming 
you chain another IDE drive off its cable, the new drive should 
be set to "slave." (You'll later have to change the jumper to 
"master"—and attach the drive to the cable's end—if you 
remove the original boot drive and make the new drive the boot 
drive.) Another option: Set both IDE drives on an 80-conductor 
cable to the Cable Select (CSEL) jumper setting. The PC will 
determine master/slave status according to the drives' placement 
on the cable ("master" at the end, "slave" in the middle). 
 
Next, look at your current hard drive to see if mounting rails are 
attached to its sides. If so, screw a set onto the new drive (look 
inside the case for spares), then slide the drive into its bay. 
Otherwise, screw it directly into the bay. Four screws are 
sufficient. Usually, the label side points up; mimic the boot 
drive. 
 
Attach one end of the SATA data cable (which is keyed for 
correct insertion) to a SATA port on the motherboard or 
interface card, the other to the drive. IDE data cables, also 
keyed, usually have a red stripe that lines up with the "pin 1" 
marking on the drive. 
 
Next, plug the power-supply lead (keyed, too) that you scouted 
out in step 2 into the drive, including any necessary extender or 
adapter. Then close the case.  
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Step 4: Configure the BIOS 
 
Next, boot into your PC's BIOS-setup 
utility to verify that it recognizes the 
new drive and positions it correctly in 
the drive hierarchy. (Check your PC's 
startup screen to determine which key 
launches the utility.) Once there, also 
check that "auto-detect" is selected for 
the drives, if an option. If the utility lets you select the boot 
order, give your intended boot drive priority over any other hard 
drive. This information may be under Boot Options, Boot Order, 
or Boot Sequence. 
 
Save changes and exit the utility. Your PC will reboot. 

Tip: Using a SATA PCI interface card? It may have its own 
BIOS to check.  
 
Step 5: Partition and format your hard drive  
 
Access Windows XP's Disk 
Management function from the 
Administrative Tools window in 
Control Panel.  
 
 
Our PC runs Windows XP, which 
lets you partition and format drives 
within Windows. Older Windows versions, such as 98 and Me, 
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make you do this from DOS. 
 
With XP and 2000, though, use Windows' Disk Management 
utility. Click Start > Control Panel > Administrative Tools > 
Computer Management, and choose Disk Management from the 
tree at left. Your new drive should appear, with a black bar 
indicating it isn't partitioned. Right-click the bar, and choose 
New Partition to launch the New Partition wizard.  
Click Next, and check that Primary Partition is selected; click 
Next again, to the Specify Partition Size screen (don't change the 
partition size in the "Partition size in MB" field); and click Next 
to advance to another screen, on which "Assign the following 
drive letter" should be selected. Click Next yet again (to the 
Format Partition screen), and ensure that "Format this partition 
with the following settings" is selected and that the "File 
system" drop-down reads "NTFS." Click Next a final time, hit 
Finish, and formatting begins. 
 
Formatting could take an hour or more, depending on drive 
capacity. But don't be surprised if your formatted drive has less 
capacity than the package claims. A 320GB drive, for instance, 
formats to about 300GB. Drive manufacturers advertise 
preformatted size, but a portion of the drive is inaccessible. 

Android Tablets for School 
S. Ranichandra 

Lecturer, Dept of CS 
KSRCAS 
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Can't splash out for an iPad? These low-cost Android tablets 
bring plenty of functionality for half the price or less. 

Apple owns an oversize slice of the tablet market 
today—for good reason, mind you. Its tablet 
hardware, now in its third generation with the Retina-
display–enabled 2012 iPad, is rock-solid, and the 
company still sells its very viable iPad 2 (the 2011 
iteration of the original iPad) in one version for a very 
competitive $399. Apart from all that, of course, is the question 
of apps: The selection and breadth of Apple's App Store is, to 
put it mildly, unmatched.  

If you're looking at a full-size tablet today, and you're willing to 
spend at least $400, the iPads make a very compelling case. 
That's especially true if you've already bought into Apple's apps-
and-media world with other gear, such as an iPhone. That said, 
dropping $400 or $500 for a non-essential piece of technology is 
a pipe dream for many students today. Plenty of them are 
saddled with school loans, killer book bills, a work-study job, 
and other, non-negotiable tech purchases, such as a laptop for 
class. 

Two years ago, that would have put a tablet out of reach. Not so 
now, though—if you're willing to compromise a bit, and work 
with an Android tablet. Here in 2012, Android tablets come in 
two essential kinds: full-size ones, with screens from 9 to 10 
inches diagonal (which approximate the size of the iPads' 9.7-
inch displays), and compact slates, most with 7-inch screens. We 
first saw Android tabs break through the $300 price floor, then 
the $200 one, with 7-inch models. To our surprise, full-size 

http://computershopper.com/tablets/reviews/apple-ipad-2012-version-wi-fi
http://computershopper.com/tablets/reviews/apple-ipad-2-wi-fi


[ISHARE MAGAZINE – DECEMBER ]  2012 
 

30  

 

Android slates have followed suit quickly, with several now well 
under $300. 

Of course, with budget tablets like these, you can't expect the 
butter-smooth interface polish and unimpeachable build quality 
of an iPad or a premium Android slate like the Asus 
Transformer Pad Infinity TF700. (Then again, you could buy 
two for the cost of one new iPad.) But for basic Web browsing, 
media playback, and e-reading, as well as enjoying the Android-
app fruit of Google's still-impressive Play Store, these five tabs 
below are all very able picks. Here's what to consider if you're 
shopping low-cost tablets for school use... 

The right size: As we mentioned, low-cost tablets come in 7-
inch and 9-to-10-
inch variants (with 
a few outliers, such 
as the lukewarm 8-
Inch Tablet from 
Vizio that we 
looked at last year). 
We suggest trying 
models of both screen sizes to see if a 7-incher will cramp your 
style. Obviously, a 7-inch tablet will be more portable, but even 
the larger tabs are generally well below 2 pounds—not exactly 
burdensome. You can carry a tablet of either size, plus a laptop, 
in a backpack without crowding out your books. 

The right interface; As time goes on, we're seeing less 
aggressive "skinning" of the Android interface on most tablets, 
which is a good thing. "Skinning" is the addition of a custom 
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interface in place of parts of the standard Android interface, and 
generally speaking, a tablet with heavily skinned Android will 
get version upgrades slower down the line than those that use 
vanilla Android. (Check out reviews of the tablets you're 
considering for detail on their specific interfaces.) The latest 
tablets feature the Ice Cream Sandwich (ICS), or 4.0, version of 
Android. Serious bargain-basement or clearance-priced tabs may 
support older Android operating systems, such as Gingerbread 
or Honeycomb; check that upgrading to ICS is supported before 
you buy. Others, such as the Le Pan II below, debuted with an 
earlier OS (Honeycomb, in its case) but have been updated to 
ICS midlife. 

The right connections:Budget tablets like these below will 
be Wi-Fi-only models. (Some premium tablets are sold with a 
cellular data plan for anywhere 
access...not these.) Look, however, 
for the proper ports and 
connections to complement how 
you'll use a tab. An HDMI output 
will let you share your tablet's 
screen with a larger monitor or 
HDTV; a MicroSD slot will let 
you expand the onboard storage—
perhaps important to you for stowing videos or music. Neither is 
a given, so shop around. 

A workable camera;If you plan to use your tablet for video-
calling with the folks back home, or other video-conferencing 
tasks, make sure it has a screen-facing camera. Many budget 
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tabs only have one cam, on the back, for taking pictures or 
videos of other folks, using the screen as a guide.  

Control Mouse Movement by your Hand  
or Head Gestures with NPointer 

S.Prema, Leturer in Dept of Cs,KSRCAS 

      If you need to work much on the computer (like me) 
and tend to take small breaks to sit back and lean on the 
chair, then you must have felt the need of  some 
wireless mouse controller then this post is worth reading. In 
case you just wish to have some gesture controlled mouse 
controller, then also this 
post is going to interest 
you. 
There are lot of tools in the 
market using which you 
can control your mouse 
without any direct contact. 
Some of them use the 
webcam to recognize your 
movements and convert the 
signals into mouse movements. One good tool that does the 
same and does well is called the NPointer. 
 
NPointer is an application for gestural computer control in 
which hand movements are recorded by the webcam connected 
to your PC and then translated into the mouse movements. The 
application can also decode the usual mouse operations like 

http://www.softgenius.co.in/2012/11/control-mouse-movement-by-your-hand-or.html
http://www.softgenius.co.in/2012/11/control-mouse-movement-by-your-hand-or.html
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clicks, double-clicks, drags and scrolls. Also, disabled people 
can also use the head movements to control the computer. 
To get started you just 
need to install the tool 
in your system and 
then configure it to 
recognize your 
hand/head movements. 
If you plan to use your 
hand for the mouse 
control, then place 
them on the table and 
keep the webcam 
straight up. You may wave the hands in air too but table method 
is better for error free recognition. 
 
You then need to configure some settings like Motion Speed 
(how fast the pointer will move compared to the hand 
movement), Acceleration (how fast the pointer accelerates 
when hand motion speed changes), Menu timeout (how long 
the pointer should stay idle before action menu appears) and 
Movement cut-off (how fast the hand should move to ignore the 
movement. This is used when you wish to remove the hands 
without disturbing the pointer position). If you check the 
Head/Frontal Control box, then you can use you head in place of 
hands to control the mouse movements. 
You will now see some controls on the screen which can be used 
to perform the same operations as performed otherwise. The tool 
is free to use and works well on all versions of Windows. You 
can read more about it at the link below. 
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